
It’s a new year! I don’t know about you, but 

boy am I ready for it. 2020 was a doozie. 

Ortho2 has some new things going on this 

year, and I wanted to make sure you are 

aware of them.

Live From Iowa – A UGM 

Special Event
While I was saddened to announce the 

postponement of our annual Users Group Meeting, I am delighted 

to tell you about this virtual event. Live From Iowa – A UGM Special 

Event is a one-day virtual meeting that will give you access to 

experienced Ortho2 trainers who will teach on various topics to give 

you and your team the tools you need to use Edge Cloud to the 

fullest. And the best part, this UGM Special Event is free! I hope you 

will join us on Friday, February 19, 2021. The meeting will run from 

9:00 A.M. to 5:30 P.M. Central time and will feature such classes 

as Edge Cloud 101, working smarter in Edge Cloud, new features 

of Edge Cloud, and marketing with Edge Cloud, to name a few. 

Registration is now open, so sign up your office today at  

www.ortho2.com/ugm. And be sure to reserve January 27-29, 2022 

on your calendar for our 37th annual Users Group Meeting in Las 

Vegas.

New Ortho2.com
Throughout much of 2020, 

we have been hard at work 

developing a new Ortho2.com. 

With both existing users and 

prospective clients in mind, the 

new website offers a much more 

streamlined and straightforward 

experience. This new, easy-

to-navigate website features vivid images, redesigned videos, and 

concise text. Existing Edge Cloud users can more easily explore 

facets of the software they may not be utilizing, and ViewPoint users 

can take a deep dive into all Edge Cloud has to offer. Note: The 

secure and customer-only facing portion of our website might not 

be fully complete at the time you are reading this, but rest assured 

is coming soon. This new design will also feature a more streamlined 

and user-friendly experience for you and your team including help 

documentation and videos, accounting services, support tools, and 

more.

inVisit – Virtual Appointments by Ortho2
And last but certainly not least, inVisit. I first wrote about inVisit, 
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Are you the only person in your office who sees the  
newsletter? Pass it along! 

You can also read the newsletter on our website  
www.ortho2.com > Our Company > Newsletters.

THE NEW ORTHO2.COM

You have probably already seen the new Ortho2.com, but in 

case you haven’t, we’d like to walk you through some of the 

changes. 

If you are looking for help videos and documentation or 

integration specs, the easiest way to find it is to visit  

support.ortho2.com. This direct link will take you to the login 

page for the customer site of Ortho2.com. It features a more 

streamlined navigation system so you can easily find the 

information you are looking for.  

In addition, you should go to support.ortho2.com to get 

remote support from the Software Support, Network 

Engineering, and New Customer Care Teams, and to log 

into your Ortho2 account to access your Ortho2 financial 

information. 

You may even want to explore the Edge Cloud page to 

view all the features in Edge Cloud. This benefits both Edge 

Cloud and ViewPoint users so they can learn more about all 

the ins and outs of Edge Cloud. Find this by hovering over 

Our Solutions in the main menu > Edge Cloud.

We hope you enjoy the new features of Ortho2.com! 

We are excited for our virtual Users Group Meeting in 2021! We are sad we 
won’t be able to see each other in person, but we still want to bring you 
the best information about Edge Cloud. 

Mark Friday, February 19, 2021 on your calendar for Live From Iowa: A 
UGM Special Event. 

This free, one-day online workshop will feature classes from our 
experienced Ortho2 trainers about various topics to give you the tools you 
need to use Edge Cloud to the fullest. We’ll even have trainers on hand to 
answer your most pressing questions.

And while there won’t be a costume contest, we encourage you to dress in 
your best flannel and ball cap to show your Iowa state spirit.

Register now at www.ortho2.com/ugm.



EDGE CLOUD TIDBITS
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The 2021 virtual Users Group Meeting is coming up next 

month. To get ready for Live From Iowa: A Special UGM 

Event, let’s talk about using Edge Cloud to its fullest 

potential. The Edge Cloud software is a jack-of-all-trades. It 

is powerful because of the many features it has throughout 

the software. So many in fact, that many of them often get 

overlooked. Here are some lesser known features that can 

easily get overlooked, but can help you work smarter. An 

ongoing theme of the UGM Special Event! 

Financial and Insurance
•	 When posting AutoReceipts, have you ever accidentally 

skipped one you shouldn’t have? If you catch yourself 

before the end of the day, you can undo this skip. Look 

for the Undo Skipped option in the AutoReceipt Review 

Screen. You can only undo the skip from the computer 

where the skip was originally made.

•	 You also have an Undo option after you click Delete in 

the Electronic Insurance Queue. You only have a few 

seconds to undo this, though.

•	 Sometimes ledgers can be confusing after you reverse 

or adjust payments or charges. You can filter the ledger 

so the adjustment is right next to the payment or charge 

even if they happen on different dates. To do this, go 

into the Filter bar and check Group Adjustments. 

•	 Want to fill in the Remarks line on the insurance forms? 

In a patient folder, open the Insurance tab. Then, click 

on the ADA Form fields line, check the Custom box next 

to Remarks, and type away.

•	 Have you ever wanted to bill insurance for something 

that is included in the contract? Records for example. 

In the Insurance tab of the patient folder, use the 

Additional Services Provided area to bill insurance for 

anything you want that has an insurance code. 

Patient Communication
•	 Tired of typing “Come on in, we are ready for you now” 

over and over in text messages to patients? Save text 

messages for the future by clicking the Save icon to the 

right of the message. Then, use the drop-down menu 

where you type in the text message to access that text 

again.

Patient Widgets
•	 There are six different patient widgets you can add to 

the patient information panel to customize what you 

see. When you are in a patient’s folder, click the Widget 

Library in the main menu. In the Patient Folder tab, you 

will see the options for the Patient Folder Widgets. Click 

any of these to add it to the patient folder. 

If at any time you want to delete a section, simply hover 

over the heading of the section and click the X. These 

widgets are user-specific, so each user can see exactly 

what they want to. 

Patient Folder
•	 Visual tags can be created and assigned to patients and 

responsible parties. Visual tags consist of user-defined 

shapes and colors that can be used to “tag” a record for 

classification or subgrouping purposes. Visual tags are 

visible in the patient record, responsible party record, 

Patient Tracker, and Post Payment window.

You can create your own visual tags by going to Editors 

> Visual Tags. Commonly used examples include: Needs 

Extra Time, Special Financial Arrangement Made, and 

Prefers Dr. X.

Contact Info: ortho2support@ortho2.com • 800.346.4504

Derek Dohrman, Advanced Tech & 

Trainer, has worked at Ortho2 for 15 

years and has done countless on-site 

and remote trainings. He enjoys playing 

games, video and board, trail walks 

with his dog, and keeping up with new 

computer technology.

About the Author
Edge Cloud Tidbits continued on page 14

THE ORTHO2 LEGACY

How Dr. Edward Cronauer ended up with Edge Cloud in 

his orthodontic practice actually started with his father’s 

orthodontic practice. His father, the senior Dr. Edward 

Cronauer, was an orthodontist in south Florida for more than 

30 years. During that time, Dr. Cronauer, Sr. used OneTouch, 

Ortho2’s MS-DOS practice management software. 

Dr. Cronauer, Jr. remembers spending a lot of time 

shadowing his dad and even assisted in setting up a new 

office after a move. He recalls OneTouch being easy to 

transition onto new computers and servers after the move. 

Seeing first hand how the software worked, and the support 

that the senior Dr. Cronauer received from Ortho2 was 

important for making decisions in his own practice.

Fast forward to 2020, where Dr. Cronauer acquired a 

practice from a retiring doctor in February, and re-branded 

it as Glades Orthodontics. The operation has three offices 

in Florida. When Dr. Cronauer took over the practice, all 

the patient charts were still on paper, and the only software 

was for the schedule and to manage financials. Dr. Cronauer 

explained the challenge of having paper charts to cover 

three office locations, especially when patients would be 

seen at multiple locations. His first order of business when 

looking for a practice management solution was to transition 

to digital charting. 

While looking for solutions to his charting problem, Dr. 

Cronauer was also looking for a cloud product for his 

software. “I have a degree in computer science from 

college, so I am pretty proficient with technology,” he said. 

“I considered implementing a central server and connecting 

the offices via VPN connection like I did for my father. My 

prior associate job used Dolphin running on a central server. 

While it definitely can be done and function well, I decided 

the advantages of the cloud outweighed the central server – 

easier IT management (I could do it myself with less hassle), 

outsourcing backup and security management to Ortho2, 

and access to office data on my phone or computer from 

virtually anywhere without a VPN.”

In addition to the benefits of the cloud, Dr. Cronauer 

decided on moving to Edge Cloud because of the 

proficiency of the support staff if he needed help with the 

software, and the level of customization of forms, letters, 

and reports. 

He remembers, “When my father did run into issues, Ortho2 

was easy to reach and despite the software being decades 

old, they still had techs that knew their way around it so well, 

they could fix nearly anything within minutes. This definitely 

played into my decision to go with Ortho2 in my office, 

as the support was great and their continued support for 

legacy software instead of forcing users to switch was much 

appreciated.”

Because of the coronavirus, implementing Edge Cloud was 

different than expected. Instead of on-site training, the team 

was trained remotely, and because of shut downs, the team 

couldn’t start using Edge Cloud right away. Dr. Cronauer 

said the bright side of this situation was the team had more 

time to learn menus, features, and customize letters and 

reports to their needs. 

Now that Glades Orthodontics is open again, Dr. Cronauer 

has seen many benefits from Edge Cloud. “It’s really nice 

to be able to work from home and look up patient charts 

when needed outside the office,” he said. “I really like all of 

the reports I can run and my ability to monitor the practice. 

I was pleasantly surprised to find out that I can upload my 

patient’s final model scans into their charts in Ortho2, which 

is a great way for us to save them with no limit on file space 

and automatic backups.” 



Have COVID-19 protocols overwhelmed your front desk 

and affected your connection with patients and parents? If 

so, you’re not alone. Since quarantine began, all of us have 

learned to deal with the changes in patient care. Whether 

you are seeing a first-time patient or a deband, the process 

of moving a patient from parking lot to chair has become 

extremely challenging. Our reception areas are closed and 

most practices are replacing them with cars, using texting 

or phone calls to move patients through. In most cases, 

this means lots of texts, calls, and frustrated patients and 

parents in your parking lot. 

So how do we overcome these missed connections and 

front desk frustrations and still maintain our COVID-

19-appropriate workspace? Technology can make the 

difference in how we practice right now. Frustrated 

front desk team members are finding success with 

communication technology. Texting your current patients 

through Edge Reminders from Ortho2 with COVID-19 

and first appointment forms has been very effective. 

Other texting platforms such as Weave also offer similar 

functionality. My Smile Appointment uses a dashboard to 

automate the check-in and screening process eliminating 

the need for back and forth communication and freeing 

your front desk to focus on patients. It also has a 

component for parent communication and video chatting. 

All of these systems help you move patients through faster 

and more effectively. 

In addition to frustration at the front desk, we are also 

seeing a lot less of the parents of our young patients. In 

some cases, doctors and team members have chosen an in-

person method to communicate with parents, running out 

to see parents in the car after each visit. Other doctors have 

found that video chats, calling, and texting results of the 

visits through an online platform works better and is more 

efficient. None of these solutions gives us the same level of 

interaction we had pre-COVID-19 with our patient families, 

but they are effective ways of communicating during these 

times. 

Connecting with parents is crucial and winter months make 

it harder for in-person outside chats. Getting out of your 

comfort zone may be the best way to reach parents. Texting 

deband photos, funny smiles, doctor/patient action shots or 

videos to parents waiting in the car can be a surefire way to 

get some love on social media. Remember to post to your 

social media as much as possible with images of your team 

and practice, and the ways in which you are staying safe 

and creating amazing smiles. Posting on social media is key 

to helping parents feel safe and comfortable with your new 

protocols. 

Using video conferencing technology has been a game 

changer over the pandemic. Most families have learned 

to use Zoom or video conference very effectively and 

therefore connecting with you at the practice this way is 

not out of the norm for them even though it might be for 

you. Virtual appointments have become necessary with 

patients who can’t or don’t feel comfortable coming to the 

practice in person. Virtual visits, initial consultations, and 

recall appointments have become more frequent and more 

effective as we have all learned to use conferencing to our 

benefit. Many practices have found that technology can 

assist in ways they never dreamed of before. 

Grow outside your box and find ways to bring your parents 

and community closer.

The in-person communications you had pre-COVID-19 can 

now be done through technology. Volunteering to sponsor 

school events, charities, or sports can all be done over text. 

TERRIFIC THOUGHTS IN  
TOUGH TIMES

General Colin Powell addressed the 2000 AAO meeting in a 

powerful opening session. I sat near the front mesmerized, 

and wrote a quote down that he said to us. It certainly 

applies today, “If you’re not riding the wave of change, 

you may find yourself beneath it.” Look back throughout 

the years at the many changes in orthodontics. But also 

look back only to March and see the many changes in your 

practice, your physical office, your patient care delivery, 

your communication, and in YOU, yourself. I talked with a 

team about this recently as I observed patient care in their 

quality orthodontic/pediatric dentistry practice. 

Rather than hear MY words to describe how they feel about 

work today, I want to share THEIR thoughts and words with 

you. I merely said to them, “Tell me how life back at work 

has changed since the pandemic.” It was my joy to hear 

them share more good thoughts than unhappy or regretful 

ones. 

Welcome to the heart of Team Styrt.

Dr. Styrt, Orthodontist, “I now have a real attitude of 

gratitude and find I focus much more on important things. 

I see how happy my team is to see each other and be 

together. They’re not afraid, we’re very careful, our patients 

are glad to be here and see our efforts to protect them. 

Best thing for me? I lost no team members during this 

trying time; they all happily came back.” 

Dr. Hayes, Pediatric Dentist, “Being a professional, I 

wonder daily how will dentistry fare through this? How will 

many stay afloat and keep up with all the information and 

changes coming at us every day? My biggest concern? Can 

I give the best care and advice to my patients and families? 

Then I go home to a seven- and a four-year-old who want to 

ride bikes, take walks, and need homework time. We are a 

closer family now – at home and at the office for sure.” 

Mackenzie, Clinical Specialist/RDA, “Some of our patients 

were scared to come back and I know we must reassure 

them by telling and showing them all we have learned and 

done to protect them and ourselves. I am so much more 

cautious of how careful I have to be and how easy it can 

be to spread the virus. Most important thing I learned? 

Patients really watch us work now – everything we do is 

important.” 

Dina, Clinical Specialist/RDA, “Have to admit, I sure don’t 

like wearing this PPE, especially the times when it is not 

needed. I now have a wider perspective on how I see just 

about everything and am more mindful and sensitive to 

what others might be going through. I am so sorry I can’t 

hug my teammates and my patients when I want to. I do 

love hearing patients tell me how they are happy being with 

their family more. The greatest change for me? I‘ve had to 

learn how to smile with my eyes.” 

Colette, Clinical Specialist/RDA, “I am so grateful to 

have both my job AND my health. I love that our patients 

are well and so happy to be here to see us – that put our 

practice stats up and we’re really busy. I do want the kids 

back in school – so many of them are home alone when 

mom and dad are at work now. Many parents don’t know 

the teaching technology and had to hire tutors to help their 

kids. The saddest thing for me? Both of my parents got 

the coronavirus, and my step-dad died from it. I know the 

seriousness of this pandemic.” 

Patty, Practice Administrator/Treatment Coordinator, 

“We’re so good now at educating our patients on the 

phone, in emails/texts, and verbally once they are here on 

what to expect. I’m blessed to have my grown daughter 

WHEN YOUR RECEPTION ROOM IS A 
CAR, TECHNOLOGY IS YOUR FRIEND

Technology continued on page 15
Terrific Thoughts continued on page 15

Contact Info: rosemarybrayortho@gmail.com • 760.330.9996

Rosemary Bray spent 30 years employed 

as a team member herself and now 

more than 21 years as a consultant and 

speaker in orthodontics and dentistry. 

She has traveled the world in the name 

of teeth and is honored to be the 

2021 recipient of the prestigious AAO 

Outstanding Service Award.

About the Author

6	 7

Contact Info: beth@practicemarketer.com • 818.459.3784

Beth Leach is principal 

in PracticeMarketer, and 

PracticeRetriever. She is an expert 

in combining the latest online 

marketing strategies with the most 

effective traditional modes of practice 

promotion. 

About the Author



dependent on the percentage of patients treated with 

aligners.

A percentage of the aligner appointments can also be 

done virtually, rather than in-office. This helps to reduce 

the number of patients seen on a daily basis (especially 

more important now while dealing with COVID-19 safety 

guidelines).

When I design scheduling templates, doctors using aligner 

treatment can accommodate more patients per day, due 

to the decreased chair and doctor time. Although this may 

sound great, there are additional considerations to consider. 

One is the lab fee, which is sometimes as high as $1,850 

per case. Although, in the long run I have found Invisalign 

can be more profitable, it can be very expensive for doctors 

to start patients. As the number of aligner starts increases, 

fortunately the lab fees decrease, depending on the number 

of starts per quarter and year. When you weigh the cost over 

the time saving, many doctors find that they can be very 

profitable, despite the increased cost.

More importantly, I see doctors struggling to find the time 

to treatment plan and submit the ClinCheck to fabricate 

the aligners. Unfortunately, many doctors are trying to 

get this done over their lunch time, after work, and on 

the weekends. The chair time per patient has decreased, 

however the doctor is spending more time on behind the 

scene aligner treatment plans. 

Over the years, I have created templates for hundreds of 

orthodontic practices. Often, when I am contacted by a 

potential client, their goal is to streamline the schedule. This 

is often accomplished by creating a doctor-time schedule, 

allowing the doctor to be needed at only one chair at any 

given time. It reduces stress on the doctor and team, as well 

as helps to ensure that patients are seen on time and the 

appointment ends on time.

With the strong influx of Invisalign or aligner treatment, 

I have found that it is beneficial to adapt the schedule to 

allow time for the doctor to complete the behind the scene 

task to treatment plan and submit the ClinCheck during 

the patient day. I have done this in a few different ways, 

depending on what method works best for the doctor and 

team, their treatment style, and philosophy. The options I 

have found to work best are:

1.	 Block out 45–60 minutes per day for the doctor to have 

uninterrupted time to complete the treatment plan and 

ClinCheck. The team continues to see patients during 

this time, however they are either finishing a procedure 

or seeing patients for non-doctor procedures (scans, 

records, delivering initial aligners – where the doctor is 

not needed until near the end of the appointment, etc.).

2.	 Build in 10–15 minutes of doctor time at the end of 

each aligner scan to allow the doctor to complete the 

treatment plan and ClinCheck for the patient at the 

time of the procedure.

3.	 Train a key clinical team member to be your Invisalign 

coordinator. They would work closely with the doctor 

to help manage ClinChecks during the time which is 

blocked out on the schedule. The Invisalign coordinator 

would also manage the Invisalign correspondence 

and track scans, aligner deliveries, and refinements. In 

addition, they would run the deband monitor at the end 

of each month to track aligner profitability.

Although there is an added expense up front, I have 

found the Vivera retainers to have the potential of being 

ALIGN YOUR PRACTICE FOR THE FUTURE OF ORTHODONTICS

Reflecting on my 45 years in the dental and orthodontic 

field, I am amazed by the changes in the industry. In 1975 

I worked with a general dentist who offered “orthodontic” 

treatment for children. His treatment of choice was to 

extract four permanent bicuspids and then close the space 

with Hawley retainers. I had the same treatment done by 

a general dentist when I was 12-years-old. The result was 

far from ideal, and it limited my treatment options when I 

decided to be re-treated by an orthodontist as an adult.

When I started in the orthodontic field in 1978, treatment 

typically involved banding the six- and twelve-year molars, 

and then bonding the rest of the teeth. Starting a patient 

took multiple appointments over several weeks. The 

sequence of appointments was as follows:

1.	 Initial exam

2.	 Full records

3.	 Consultation

4.	 Separators

5.	 Band the molars

6.	 Bond the remaining teeth and place arch wires

After the patient was fully banded, they typically were 

seen every 4 weeks for a period of 2–2 ½ years. This meant 

that most patients were seen 32+ times over the course of 

their treatment, excluding the retention phase. Scheduling 

logistics limited the number of active patients due to the 

frequency of appointments needed to complete their 

treatment.

Gradually throughout the years, practices transitioned to 

taking records at the initial appointment. In most cases 

the formal consultation has been eliminated, unless it 

is a difficult case, or it was determined that the patient/

parent required additional information prior to the start 

of treatment. Additionally, many doctors are eliminating 

the use of bands and bonding patients 7–7. Patients are 

often given the opportunity to start treatment at the initial 

appointment, reducing time missed from school or work. 

Many orthodontists now see patients every 6–10 weeks, 

reducing the number of appointments from 32+ to 20 or 

less. Chair time for patients has decreased from 30–45 

minutes to 15–30 minutes due to self-ligating brackets and 

improved arch wires.

In 1997 Invisalign entered the profession, offering 

removable aligner treatment as an option for full treatment. 

Currently, more than 5,000,000 patients have been treated 

using Invisalign. This does not include patients who are 

treated with clear aligners, available through companies 

other than Invisalign. Patients in aligner treatment are 

often seen every 8–12 weeks, reducing the number of 

appointments over the active treatment time to 10–14. 

Aligner treatment has transitioned from adult only 

treatment to teenagers and children.

So, what does this mean to orthodontic practices that 

are now treating 30-70% of their patients with aligner 

treatment? The result is that you can start more cases, as 

active aligner patients are scheduled on a longer rotation. 

Your production can often increase 20-50%, as you have 

opened time in your schedule by reducing the number 

of times a patient is seen during their treatment time. 

Other than the initial placement of aligners, refinement 

appointments and deband, the average chair time for 

aligner visits is 10–20 minutes.

Over the past year, approximately 60% of my clients have 

increased the number of patients they treat with aligner 

treatment. Many doctors have made the decision to offer 

aligner treatment to many of their patients, including 

teenagers and children. 

This can have a big impact on your patient schedule. 

The long bonding appointment has been replaced with 

the initial placement of attachments and aligners. This 

procedure requires very little doctor time, as typically 

the clinical assistant places the attachments. The doctor 

removes the excess flash and checks the fit of the initial 

aligners. This has reduced the time needed for the start 

appointment from an average of 90–120 minutes down 

to 45–60 minutes. With the decrease of the number and 

length of visits required for aligner patients, it can often 

open up one or more hours per day for each patient 

chair. The result is that you can see more patients per day, 
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Debbie Best, senior practice management 

consultant and lecturer for Debbie Best, 

Consulting Network has over 45 years of 

experience in the dental and orthodontic 

field. Debbie evaluates staffing needs and 

the office computer system to develop a 

strategic plan for practice productivity.

Contact Info: debbiebestconsulting@gmail.com • 206.310.6055

About the Author
Align Your Practice continued on page 14
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FREE WEBINARS
We offer you free, online webinars each month throughout the year on various topics. It’s a great solution for training new 

users, refreshing experienced users, or learning about new features. Webinars are available online at www.ortho2.com > Our 

Company > Ortho2 Webinars. Find the topic for the month and click the link to view the webinar at your convenience.

Upcoming Webinar Topics

 

ORTHO2 ANNIVERSARIES
Congratulations to these Ortho2 staff members who celebrated anniversaries during the fourth quarter of 2020.

 

January – Edge Cloud: Open-ended Contracts

In some instances, you may need to create contracts without 

an end date. You can create open-ended contracts in Edge 

Cloud to accomplish this. This webinar will review the steps 

for creating and managing this type of contract. 

February – ViewPoint: Light Bar Widget

Use your Light Bar widget to monitor the doctor’s 

involvement with patient appointments once they have 

been processed as “seated” in your On-Deck Operatory. 

The light bar notifies you about who the doctor is currently 

attending, directs the doctor to the next patient that should 

be seen, and alerts you to patients that have been waiting 

an extended period of time. We will demonstrate how to 

access the widget, choose your settings, and use the light 

bar.  

March – Edge Cloud: Edge Specialist Set Up

This webinar will walk you through the steps you need to 

take to get Edge Specialist ready in your practice. We will 

review how to set up your editors, dental procedure groups, 

insurance fee schedules, appointment types, and treatment 

chart styles.

Twenty-Eight Years
Todd Schuelka

Twenty-Six Years
Michele Eich

Twenty-Two Years
Lowell Davis 

Denise Sargent 

Jennifer Shaffer

Sixteen Years
Corey Schmidt

Fifteen Years
Derek Dohrman

Eight Years
Brian Good 

Drew Humphrey

Seven Years
Steve Volcko

Two Years
Paige Seward

One Year
Dylan Groves
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CAREER MILESTONES AND DEVELOPMENT
The Software Support Team has two new members. Chloe Enos and Michaela Henke joined Ortho2 on November 2.

Chloe is a recent graduate from Iowa State University with a Master’s of Art in graphic design and a Bachelor’s of Design. 

Prior to joining Ortho2, Chloe was a freelance graphic designer and an art tutor.

Michaela is also a recent graduate from Iowa State University with a Bachelor’s in biological and pre-medical illustration. 

Michaela gained customer service experience while working at Wild Birds Unlimited before coming to Ortho2. 

ON A PERSONAL NOTE
Congratulations to Jess Huennekens, Ortho2 Regional Manager, and his wife, Jessica on the birth of their son Elliott Roland 

on November 24. Elliott is joined at home by big brother Liam. Congratulations Huennekens family!

November 24 was a busy day for new family members. Steve Volcko, Ortho2 Regional Manager, and his wife, Emily, 

welcomed their daughter Vivian (Viv) Olivia that day as well. She was 20 inches long and weighed 7 lbs., 2 oz. Viv is joined at 

home by big brother Emmett and big sister Stella. Welcome to the world, Viv!

SERVICE EXCELLENCE
We invite you to recognize Ortho2 employees by completing an Extra Mile card. Simply fill one out online by going to www.

ortho2.com > Our Company > Contact Us. Our goal is to uphold our tradition of excellence in customer service, and with 

our Extra Mile program, you can let our employees know when you appreciate their extra effort. We encourage you to send 

an Extra Mile card whenever an Ortho2 employee goes the extra mile for you. The recognition is valued by the recipient 

and is acknowledged by our management team. We continue to look for better ways to serve you. Thank you for helping us 

recognize excellence. 

Elliott Roland
Viv Olivia
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Dylan Groves

Vacation destination: The Amalfi 

Coast

Three people I would like to have 

dinner with: My Father, Joe Rogan, 

and Ed Snowden 

My role model: My father, Stanley 

W. Groves

I can’t go a day without: The gym

What are you listening to right now? The Miseducation of 

Lauryn Hill

Favorites

Team: University of Georgia Bulldogs

Software Program: Steam

Movie: The Matrix

Book: The Iceman: Confessions of a Mafia Contract Killer by 

Philip Carlo

Phone App: Instagram

Jo Jacobson

Vacation destination: A cabin on a 

lake

Three people I would like to have 

dinner with: Mom, Grandma, and 

Grandpa 

My role model: Mike Jacobson. A 

salt of the earth guy and the kindest 

person I know.

I can’t go a day without: Planning out the next renovation or 

garden project – I have endless ideas.

What are you listening to right now? Pandora: Symphonic 

Radio mix

Favorites

Software Program: Ortho2 Edge Cloud

TV Show: Currently working my way through Ozark season 3

Book: Currently reading a lot of Pete the Cat adventures with 

my grandson

Phone App: Lately, a lot of online shopping apps

MEET THE TEAM – SOFTWARE SUPPORT
Any time you have a question about Edge Cloud or ViewPoint, there are many specialists available to assist you. The 

Software Support Team takes your calls to answer your questions, assists in enhancing your software, and trains new offices. 

This quarter features Dylan Groves, Software Support Representative and Jo Jacobson, Software Support Manager.

What do you do here at Ortho2?

DG: I provide software support to end users. More or less, I 

talk to people and answer their questions.

JJ: As the Software Support Manager, I work with the 

Software Support, Advanced Support, and New Customer 

Care teams.

What’s fun/what do you enjoy about your current job?

DG: There’s a lot that I enjoy about my current role here. 

If I were to pick a favorite, I would say that I most enjoy 

interacting with new people every day.

JJ: It’s challenging and interesting every single day.

What do you want our users to know about what you do?

DG: There are no stupid questions.

JJ: It’s a large and diverse group of good people who strive 

to provide the best possible service to Ortho2 customers.

RETRAINING
Have you hired new staff since your original software training? Have you had staff members take on new responsibilities? Do 

you feel you might not be taking advantage of the enhancements that have been added over the years? Ortho2 offers many 

options for refreshing your knowledge of old features and informing you of new features, but do you want to be able to set 

your own agenda to meet the specific needs of you practice?

A retraining – either in your office or over the Internet – addresses all these issues. To learn more and to schedule one for 

your practice, contact your Ortho2 Regional Manager today at sales@ortho2.com or 800.678.4644. 

HELP US HELP YOU
Please be prepared to provide your customer number, practice name, and office location when you call our support teams 

for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will 

find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—and 

repeat your phone number—when leaving a phone message requesting support. Having clear information helps us serve 

you more quickly.

SUPPORT
By Phone: 800.346.4504

Available 7:00 A.M. – 7:00 P.M. Central 

Time, Monday – Friday

By Email: ortho2support@ortho2.com

Response time is usually the same day or 

at most within 24 hours.

And Don’t Forget Our Website: www.ortho2.com

Our website gives you 24/7 access to our knowledge base, FAQs, white 

papers, visual help videos, and more.

CHAT SUPPORT
Do you need to call into our Support Team for a question, but it’s difficult to wait on hold, even for a few minutes? Ortho2 

has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be added 

to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or Network 

Engineering Teams. 

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint version 11 and beyond, it is the 

bottom right Help button in the Daily Activities menu.

So drop us a line when you are in a pinch! We are here to help you in whatever way is most convenient for you.



Ortho2’s new virtual appointment solution, a couple 

newsletters ago when it was first released. This latest 

innovation will streamline the way you interact with your 

patients, today and into the future. inVisit allows you to 

virtually conduct appointments with both current and 

prospective patients. Patients can fill out questionnaires 

regarding desired or current treatment, and take a series 

of photos of their teeth. You can review progress of current 

patients from the inVisit dashboard to determine the next 

steps for treatment. Information from prospective patients 

can be viewed to determine if care is needed and establish 

follow up steps. inVisit lets you communicate with patients 

at times that work best for you and them. Once the virtual 

appointment is completed, set patients’ status according 

to what you want to do at the next virtual or in-office 

appointment. With inVisit, you control the number of in-

office visits your patients need to make. Start using inVisit 

today, and get your first month for only $30. Sign up at 

www.getinvisit.com.

I hope these new additions help you and your practice thrive 

in 2021 and beyond. 
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President’s Perspective continued from page 1 Terrific Thoughts continued from page 6

home and she has dinner ready for me when I get home 

from work. All my family time has become far better. A 

positive is that our doctor has become more brief and 

concise with our time-eater patients/parents. Our team came 

back willingly without complaint, keeping our morale up and 

numbers healthy. With no more spending on vacations/trips 

to Disneyland, parents now spend money on smiles! Biggest 

thing I learned? I see the impact this pandemic has had on 

others outside of orthodontics. We are so lucky.”

Michelle, Scheduling Coordinator, “I sure am more in 

tune with the flow, number of appointments, people in the 

reception now – it’s so important! We find people can cancel 

more easily and at the last minute because they don’t feel 

well. We know our patients value the appointments they 

keep more and the time the doctor spends with them. Best 

thing I see? I now feel more important and valued here 

watching the patients and our schedule closely.” 

Elizabeth, Financial/Insurance Specialist, “This virus did 

not make me fear losing my job or being financially hurt. I 

stayed confident, was able to still do my work solo through 

it all. Sure scheduling is now harder, we had to hire another 

person, and the pediatric dentistry part of our practice was 

impacted, especially by our six-month recall schedule. But, 

like I bet others have told you today, I am so grateful to be 

here to take care of it all!“ 

Gina, Treatment Coordinator, “What a way to get more 

quality and quantity of time with my family! Now I am 

so much more appreciative of life and nature and the 

friendships I have. Sad I can’t be with people more and have 

to wear this mask around my patients who want to see my 

smile. Biggest change I see here? When I’m chairside I’ve 

always asked my patients how they are doing, but now more 

often, they ask about me!”

Alex, Clinical Coordinator Specialist/RDA, “Hey, I have a 

job! I have more family time; my kids are healthy and are 

back into school now and happy to be there. Our team all 

wanted to come back as soon as we could and we are so 

grateful to have our jobs. Our doctor didn’t have to pick and 

choose who he wanted back. We were already a great team, 

and that stayed the same. He took all of us back; we are all 

really good, and we are all here 100%. What sticks out to 

me? Sure I hate that I can’t go out to places or watch sports 

events, but the positives far outweigh the negatives that this 

virus brought on.”

Cat, Health Concierge, is a new employee hired recently 

to welcome patients, take temperatures, and guide them 

on today’s process. She brilliantly told me she needs to, 

“Be kind to patients as they are anxious/worried and want 

to be told about the enhancements made and cleanliness 

guaranteed to them at each appointment. Consistency is 

critical and talking to them about how we are glad they 

are here is my job. But, I’m really in the customer service 

business more than anything.” Wow, you all need a Cat on 

your team. 

And remember, flexible people never get bent out of shape. 

This terrific team has been flexible in just about everything 

and is coming out on top in just about every area of practice 

life because of it. 

•	 You can remove the gender symbol at the top of the 

patient chart by going to User Options > Visuals > 

uncheck Display Gender Symbol in Patient Folder 

Header.

New Patients and Fast Find Window
•	 When taking that new patient phone call, search for the 

patient in the Fast Find window first to verify they are 

not already in the system. When they are not, simply 

click Add New in that same window, to pull up the New 

Patient window.

Automate Stacks
•	 Reports are great, but why run reports every day to find 

a list of patients who need follow up? Create a workflow 

to automatically add the patient to a stack. Common 

examples include: adding patients to a stack after a 

consult to remind the TC/Dr. to write up the treatment 

plan; when scheduling an exam, add the patient to 

a Verify Insurance Stack; and care calls on multiple 

appointment types. 

Edge Cloud Tidbits continued from page 4

Video gatherings for CE or fun with local dentists help you 

stay relevant in your community. Finally, get involved with 

local businesses owned by your patients and ask how you 

can help them during these times. Coming together as a 

community is one of the best ways to grow your practice 

brand and become ‘the practice’ in town. 

Think outside the box, use technology to further your brand 

and connect with your community. We will all get through 

this together. 

more profitable. The retainers require very little doctor 

maintenance, thereby freeing up your schedule to new starts 

and active patients. Since the patients have extra retainers in 

reserve, it reduces the number of patients who are seen for 

retreatment.

Scheduling templates have changed due to COVID-19 

regulations. I recommend leaving 5–10 minutes between 

procedures in any given chair. It is also beneficial to stagger 

chairs, so you don’t have patients, seated in adjacent chairs, 

arriving or leaving the clinical chairs at the same time.

Embrace the future of orthodontics. Patients have 

multiple treatment options, from seeking a trained 

specialist to having treatment done by a general dentist. 

When you throw consumer direct aligners into the mix 

(SmileDirectClub, Candid, SmileLove, etc.), it is more 

important than ever for orthodontic practices to step up 

their game to attract and retain new patients. Once we 

get the new patient through the door, wow them with 

exceptional customer service provided by a specialized 

orthodontist. As well as taking excellent care of the patient, 

respect the doctor’s personal time. Say good-bye to working 

nights and weekends, giving orthodontists more time and 

space to recharge their batteries. 

Align Your Practice continued from page 9

Amy Schmidt, Ortho2 President

Amy Schmidt

Technology continued from page 7
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